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 TUTORIAL DESCRIPTION 

  Overview 

"#$%&!'()!*(+!,$&-%.!,-/0!,(!$11011!$%2!+0/02-$,0!'()+!3(40+3(-%,!5+010%,$,-(%16!7-8+(1(*,!

3(40+3(-%,!-1!$!5(5)9$+!$559-8$,-(%!*(+!8+0$,-%.!2'%$/-8!5+010%,$,-(%16!3+010%,$,-(%1!8+0$,02!

4-,#-%!3(40+3(-%,!8$%!8(%,$-%!,0:,;!.+$5#-81;!$)2-(;!<-20(;!$%2!/(+06!=)0!,(!,#0!<-1)$9!%$,)+0!

(* !3(40+3(-%,!5+010%,$,-(%1;!0%1)+-%.!$88011->-9-,'!-%!'()+!5+010%,$,-(%1!4-99!+0?)-+0!

(+.$%-@$,-(%;!10?)0%8-%.;!9(.-8!$%2!*9(4!>0,400%!<-1)$9!090/0%,16!A'!*(99(4-%.!,#0!1,051!

8(%,$-%02!-%!,#-1!-%,+(2)8,(+'!,),(+-$9!'()!4-99!#095!/00,!,#0!%0021!(* !$!2-<0+10!1,)20%,!>(2'6!

!

"#010!.)-209-%01!40+0!4+-,,0%!*(+!,#0!BCCD!<0+1-(%!(* !7-8+(1(*,!E**-80!3(40+3(-%,6!

"(5-81!8(<0+02!-%!,#-1!,),(+-$9!-%89)20!8+0$,-%.!$88011->90!3(40+3(-%,!,#+().#!,#0!)10!(* !19-20!

9$'(),1;!$9,0+%$,0!,0:,!*(+!-/$.01;!,#0!%(,01!5$%0;!8#$+,1!$%2!.+$5#1!$%2!#'50+9-%&16!F01()+801!

+09$,02!,(!$88011->90!2(8)/0%,1!$+0!9-1,02!$,!,#0!0%2!(* !,#-1!,),(+-$96!!

!!Prerequisites 

G%2-<-2)$91!)1-%.!,#-1!,),(+-$9!1#()92!#$<0!>$1-8!8(/5),0+!1&-991!$%2!,#0!$>-9-,'!,(!4(+&!4-,#!,#0!

H-%2(41!(50+$,-%.!1'1,0/6!!

Objectives 

  I*,0+!8(/590,-%.!,#-1!,+$-%-%.!'()!1#()92!>0!$>90!,(J!

! =0*-%0!4#$,!/$&01!$!3(40+3(-%,!$88011->90!

! A)-92!$!5+010%,$,-(%!)1-%.!19-20!9$'(),1!

! I22!$9,0+%$,-<0!,0:,!,(!2018+->0!.+$5#-81!8(%,$-%02!-%!3(40+3(-%,!5+010%,$,-(%1!

! K10!%(,01!5$%0!,(!-%,0+5+0,!!8(/590:!-/$.01;!*9(4!8#$+,1;!,$>901!$%2!8$5,-(%1!*(+!$)2-(!

! L+0$,0!8#$+,1;!.+$5#1!$%2!,$>901!4-,#!,#0!3(40+3(-%,!$559-8$,-(%!

! M(8$,0!+01()+801!,(!8(%<0+,!!3(40+3(-%,!,(!$88011->90!N"7M;!M081#$+0!$%2!3=O!*-901!

!

!

How to use this Document 

P$8#!108,-(%!-1!2-<-202!>'!#0$2-%.16!H-,#-%!,#0!#0$2-%.1;!2-+08,-(%1!$+0!4+-,,0%!$1!$!%)/>0+02!

9-1,6!H-,#-%!0$8#!9-1,;!,#0!%$/01!(* !/0%)!-,0/1!$+0!>(9202!*(+!?)-8&!+0$2-%.6!Q8+00%!1#(,1!$%2!

2-$.+$/1!$+0!9$>0902!*(+!0$8#!1,056!G%2-<-2)$9!5$.01!#$<0!"-5!>(:01!,(!-%89)20!$22-,-(%$9!

-%*(+/$,-(%!%(,!-%89)202!-%!,#0!1,0516!F01()+801!$+0!-%89)202!$,!,#0!0%2!(* !,#0!2(8)/0%,6!
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 CREATING AN ACCESSIBLE POWERPOINT 

What is Accessibility? 

!

I88011->-9-,'!-%!,0+/1!(* !0908,+(%-8!2(8)/0%,1!.0%0+$99'!+0*0+1!,(!*$8-9-,$,-%.!,#0!)10!(* !

,08#%(9(.'!*(+!50(590!4-,#!2-1$>-9-,-016!3+(<-2-%.!0?)-<$90%,!$88011!,(!0908,+(%-8!2(8)/0%,1!*(+!

$99!*$8)9,';!1,$** !$%2!1,)20%,1!,#+().#(),!,#0!LQK!1'1,0/!-1!+0?)-+02!>'!QARCB6!"#-1!Q0%$,0!A-99!

0:,0%21!,#0!+0?)-+0/0%,1!(* !Q08,-(%!SCT!(* !,#0!O020+$9!F0#$>-9-,$,-(%!I8,!,(!,#0!L$9-*(+%-$!

Q,$,0!K%-<0+1-,'6!"(!90$+%!/(+0!$>(),!$88011->-9-,'!+0?)-+0/0%,1!*(+!,#0!LQK;!+0*0+!,(!,#0!

*(99(4-%.!H0>!1-,0!$>(),!,#0!I88011->90!"08#%(9(.'!G%-,-$,-<0J!

#,,5JUU44468$91,$,0602)U$88011->-9-,'U6!"#0!89$+-,'!$%2!9(.-8!>+().#,!,(!5+010%,$,-(%1!,#+().#!

$88011->-9-,'!$11011/0%,1!$%2!+0/02-$,-(%!$**08,1!,#0!0%,-+0!1,)20%,!>(2'!$%2!*$8)9,'!>'!

1)55(+,-%.!502$.(.-8$9!0%.$.0/0%,!$%2!1)880116!

!

"#0!*(8)1!(* !,#-1!,),(+-$9!-1!,(!8+0$,0!2(8)/0%,1!,#$,!$+0!$88011->90!,(!-%2-<-2)$91!4-,#!$!<-1)$9!

-/5$-+/0%,!$%2!,#$,!+0?)-+0!,#0!)10!(* !$11-1,-<0!,08#%(9(.';!1)8#!$1!$!18+00%!+0$20+!(+!,0:,!

/$.%-*-8$,-(%!1(*,4$+0!,(!%$<-.$,0!$%2!+0$2!2(8)/0%,16!=0$* !$%2!#$+2V(*V#0$+-%.!1,)20%,1!

>0%0*-,!*+(/!8$5,-(%02!$)2-(!$%2!<-20(!4-,#!-%!$!5+010%,$,-(%6!Q,)20%,1!4-,#!5#'1-8$9!

2-1$>-9-,-01;!90$+%-%.!2-1$>-9-,-01!$%2!P%.9-1#V9$%.)$.0!90$+%0+1!$91(!>0%0*-,!*+(/!,#0!*(+/$,,-%.!

*0$,)+01!(* !$%!$88011->90!5+010%,$,-(%6!

What Makes a PowerPoint Accessible? 
!
I88011->90!3(40+3(-%,!5+010%,$,-(%1!8$%!>0!+0$2!>'!$99!1,)20%,1!+0.$+29011!(* !$55$+0%,!2-1$>-9-,'6!
Q508-*-8!$88011->-9-,'!+0/02-$,-(%!*(+!$11-1,-<0!,08#%(9(.'!$99(4!18+00%!+0$2-%.!1(*,4$+0;!)102!>'!
50(590!4-,#!<-1)$9!-/5$-+/0%,1!,(!+0$2!/$,0+-$9!(%!,#0!18+00%!(),!9()26!L$5,-(%02!$)2-(!
$88(/5$%'-%.!,#0!3(40+3(-%,!$99(41!50(590!,(!+0$2!-,!4#(!8$%%(,!#0$+!,#0!5+010%,$,-(%6!
I22-,-(%$99'!$88011->90!3(40+3(-%,!5+010%,$,-(%1!-%89)20!
!
!"#$%&$'%()
3+010%,$,-(%1!$+0!5+05$+02!$#0$2!(* !,-/0!$%2!+0#0$+1026!!
N$<0!$%!0908,+(%-8!8(5'!5(1,02!-,!,(!'()+!8()+10!40>1-,0!!
!
*+,&)'"-%$.+/0&$"-%()
N$<0!$9,0+%$,-<0!,0:,!,#$,!2018+->0!$99!-/$.01!-%!,#0!2(8)/0%,!!
K10!,#0!%(,01!5$%0!,(!2018+->0!8(/590:!-/$.01;!*9(48#$+,1;!,$>901;!$%2!$)2-(!!
L(%<0+,!#'50+9-%&1!,(!,#0!%$/0!(* !,#0!1-,0!
K10!$,!90$1,!RCV5(-%,!*(%,!1-@0!(+!$>(<0!
L(%,$-%!9011!,#$%!10<0%!5(-%,1!50+!19-20!!
!
!01"2&()
K10!19-20!9$'(),1!,(!*(+/$,!$%2!(+.$%-@0!+0$2-%.!(+20+6!!
L+0$,0!,$>901;!8#$+,1!$%2!.+$5#1!8+0$,02!4-,#-%!3(40+3(-%,!(+!9-%&!,(!1()+80!2(8)/0%,1!
!!!K10!.((2!8(9(+!8(%,+$1,!!
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PowerPoint Interface 

!

3$#2/+)45)6"7+/6"$-&)8-&+/90'+)

!

!

!

!

TIP: !F02)80!(+!+0/(<0!*$1,!5$802!(+!<-1)$9 9'!8(/590:!,+$%1-, -(%16!"#010!

,0%2!,(!8$)10!18+00%!+0$20+1!,(!+0V+0$2!,#0!5$.0!0$8#!, -/0!$!,+$%1-, -(%!

(88)+16 ! !

TIP: !I99(4!1,)20%,1!,(!<-04!,#0!19 -20!5+010%,$,-(%!-%!*)9 9 !02-, -%.!/(20!

4#0+0!,#0'!#$<0!,#0!8(%,+(9!,(!<-04!,#0!5+010%,$,-(%!$,!,#0-+!(4%!5$806!

!

"#0!:"&+%)60-+!-1!)102!,(!5+(<-20!

9(%.!2018+-5,-(%1!*(+!8(/590:!.+$5#-81!

(+!$)2-(!$2202!,(!,#0!5+010%,$,-(%6!

"#0!;&0#+!8$%!-%89)20!-/$.01;!,0:,;!

8#$+,1;!.+$5#1;!$)2-(!$%2!<-20(6!

"#0!;<$.+%)0-.)

=2&<$-+)60-+%)8(%,$-%!

$99!,#0!,0:,!*+(/!,#0!

19-20;!-* !,0:,!#$1!>00%!

$2202!8(++08,9'6!!!
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Slide Layout 

!

"(!>)-92!$!5+010%,$,-(%;!8#((10!*+(/!,#0!%-%0!5+020*-%02!19-20!9$'(),1!5+(<-202!>'!3(40+3(-%,6!!

Q9-20!9$'(),1!4-99!1,$%2$+2-@0!*(+/$,,-%.!$%2!0%1)+0!,#$,!8(%,0%,!-1!5+(50+9'!$2202!,(!,#0!

5+010%,$,-(%!(),9-%06!G* !$99!,#0!,0:,!-%!,#0!5+010%,$,-(%!-1!8(%,$-%02!-%!,#0!E),9-%0!3$%0!,#0%!$!

18+00%!+0$20+!8$%!0$1-9'!+0$2!-,6!"#0!19-20!9$'(),1!#095!20*-%0!,#0!5(1-,-(%!(* !,-,901;!1)>,-,901;!,0:,;!

8(%,0%,!$%2!(>W08,1!-%!,#0!19-206!"#0!*-+1,!19-20!'()!4-99!100!4#0%!3(40+3(-%,!(50%1!-1!,#0!"-,90!

Q9-20!9$'(),6!"(!8#((10!$22-,-(%$9!19-20!9$'(),1J!

%&+>)45 Go to the Home tab on ribbon at the top of the screen  

%&+>)?5 Select Layout icon and click on the arrow to see Office Theme dialogue box 

%&+>)@5 Choose a theme to match your content 

%&+>)A5 Input content into designated text boxes. Adding extra text boxes to predefined layouts 

will disorganize reading order for a screen reader 

3$#2/+)?5)=99$'+)*B+C+%)

!

!
!

!

!

TIP: !I<(-2!)1-%.!$!D<0-E !1 9 -20! 9$'(),!>08$)10!,#0'!2(!%(,!8(%,$-%!

59$80#(920+1!*(+!, - , 901!$%2!,0:,!$%2!4-9 9 !%(,!>0!+0$2!0$1- 9'!>'!$11-1, -<0!

,08#%(9(.'!20<-801! 9 -&0!$!18+00%!+0$20+6 !

TIP: !P%1)+0!,#$,!0$8#!19 -20!#$1!$!2-1,-%8,-<0!, -, 906 !"#-1!4-9 9 !#095!$9 9 !

1,)20%,1!%$<-.$,0!$%2!)%20+1,$%2!,#0!9(.-8$9!* 9(4!(* !,#0!2(8)/0%,6!

TIP: !7$&0!*(%,!1-@0!$,! 90$1,!RC!5,16!M-/-,!>)990,!5(-%,1JRVD!50+!19 -20!

Select Layout icon and click on the 

arrow to see Office Theme dialogue box. 
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!

Inserting Hyperlinks  
 

Hyperlinks are elements within electronic documents that link to another section in the document, 

to another document, or more commonly, to an Internet resource. When inserting a hyperlink, 

provide a title for the URL or document. Screen reading software is able to pull all the hyperlinks 

into an index table. It will enhance readability if the list of hyperlinks in this table is informative 

rather than a list of long URLs or non-descriptive words such as, “Click here.” 

Inserting Hyperlinks 

 

1. Input the name of the URL, file  or email address on the PowerPoint slide 

! i.e. name of your web site, “California State University Web Site.”  

2. Highlight this text; it will become the hyperlink people will read. 

3. Select Insert Tab at the top of the page on the ribbon.  

4. Select Hyperlink. The Insert Hyperlink window will appear as below. 

5. On the left hand side of the dialogue box, select Existing File or Web Page, Place in This 

Document, Create New Document, or E-mail Address, depending on your link. 

6. If the link is to an Internet resource, type the URL in the Address text box at the bottom of 

the dialogue box. 

7. Click OK.  

3$#2/+)@5)8-%+/&)F1>+/<$-E))

 

 

  

=018+-5,-<0!,0:,!-1!-%5),!#0+06!G* !

'()!4$%,!,#0!*)99!KFM!<-1->90!(%V

18+00%!'()!8$%!$22!-,!#0+06!

3$1,0!,#0!KFM!#0+0!(+!8#((10!,#0!*-90!

'()!4$%,!,(!9-%&!,(!$%2!10908,!EX6!
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 Alternate Text for Images 

!

Y+$5#-81!Z5#(,(.+$5#1;!89-5!$+,;!*-.)+01;!8#$+,1;!0,86[!8(%<0'!-%*(+/$,-(%!$%2!5+(<-20!$%!

$,,+$8,-<0!$550$+$%80!,(!2(8)/0%,16!Q8+00%!+0$2-%.!1(*,4$+0!4-99!20,08,!,#0!-/$.0!(+!(>W08,!-%!$!

3(40+3(-%,!2(8)/0%,!$%2!4-99!+0$2!,#0!$9,0+%$,-<0!,0:,!2018+-5,-(%;!-* !-,!#$1!>00%!5+(<-2026!"#0!

,0:,!2018+-5,-(%!1#()92!8(%<0'!,#0!1$/0!-%*(+/$,-(%!,(!,#0!)10+!,#$,!,#0!.+$5#-8!5+(<-2016!

=018+->0!,#0!.+$5#-8!8(%8-109'!4#-90!8(%<0'-%.!0?)-<$90%,!-%*(+/$,-(%6!G* !'()+!.+$5#-8!-1!

8(/590:;!'()!4-99!%002!,(!$22!$!9(%.0+!2018+-5,-(%!)1-%.!,#0!-"&+%)>0-+5!

Adding Alternate Text to Images 

%&+>)45 Right click on the image and a dialogue box will open 

%&+>)?5 Select Size and Position to open the Size and Position dialogue box 

%&+>)@5 Select the Alt Text tab from the Size and Position dialogue box.  

%&+>)A5 Input a concise description in the Alternative text area. The Alt Text will be embedded 

in the image and will not be visible in the PowerPoint document. 

%&+>)G5 Click Close 

 

3$#2/+)A5)H$#B&)'<$'E)"-)$C0#+))

 

 

   

F-.#,!89-8&!(%!X0'!G/$.0!$%2!10908,!;$I+)0-.)6"%$&$"-!

3$#2/+)G5);$I+)0-.)6"%$&$"-)D",)9"/)0<&)&+,&)
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Grouping Images 

!

A'!.+()5-%.!1-/-9$+!-/$.01!,(.0,#0+!'()!8$%!$559'!$9,0+%$,0!,0:,!,(!$99!,#(10!-/$.01!$,!(%0!,-/06!

!

%&+>)J5 Select the images you want to group by holding Control and clicking on the images  

%&+>)K5 Under the Picture Tools tab, on the Format tab, in Arrange, choose Group 

 

 
Figure 6. Group image close-up. 

 

!

B6!!K%20+!6$'&2/+)*""<%!,$>!(%!,#0!

3"/C0&!,$>;!-%!L//0-#+;!8#((10!M/"2>!

\6 N(92!L(%,+(9!$%2!89-8&!

(%!0$8#!-/$.0!

)

3$#2/+)K5)M/"2>)$C0#+N)%B"7$-#)92<<)6"7+/6"$-&)$-&+/90'+5)

!

!
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Adding Alternate Text to Grouped Images 

!

%&+>)45 Right click on the images and a dialogue box will open 

%&+>)?5 Select Size and Position to open the Size and Position dialogue box 

%&+>)@5 Select the Alt Text tab from the Size and Position dialogue box.  

%&+>)A5 Input a concise description in the Alternative text area. The Alt Text will be embedded 

in the image and will not be visible in the PowerPoint document. 

%&+>)G5 Click Close 

!
!

3$#2/+)O5)L..$-#)0<&+/-0&+)&+,&)&")0)#/"2>+.)$C0#+)

!

!!

!

!

TIP:  G,!-1!%(,!%08011$+'!,(!-%89)20!,#0!4(+21;!]G/$.0!(*^_!-%!'()+!,0:,!2018+-5,-(%6!"#0!

$11-1,-<0!,08#%(9(.'!1(*,4$+0!4-99!8(%<0'!,#$,!-%*(+/$,-(%!,(!,#0!)10+;!$%2!-,!4()92!>0!

+02)%2$%,!,(!#$<0!,#$,!-%*(+/$,-(%!-%!,#0!,0:,!2018+-5,-(%!$1!40996!

!
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Write Long Descriptions in Notes Pane  

!

`(,01!3$%0!-1!9(8$,02!$,!,#0!>(,,(/!(* !,#0!4-%2(4!)%20+%0$,#!,#0!19-20!1,$.06!N0+0!'()!8$%!

4+-,0!%(,01!*(+!,#0!8)++0%,!19-206!"#0!`(,01!3$%0!-1!)102!*(+!150$&0+!%(,01!,(!$-2!$!5+010%,0+!

2)+-%.!$!5+010%,$,-(%!(+!,(!5+-%,!(),!$%2!.-<0!,(!1,)20%,16!"#0!$+0$!8$%!$91(!>0!)102!,(!5+(<-20!

9(%.!2018+-5,-(%1!*(+!8(/590:!.+$5#-81!(+!$)2-(!$2202!,(!,#0!5+010%,$,-(%6!7$&0!-,!890$+!,(!'()+!

$)2-0%80!4#-8#!<-1)$9!(>W08,!-1!>0-%.!2018+->026!O(+!0:$/590;!'()!/-.#,!>0.-%!$!2018+-5,-(%!>'!

5+(<-2-%.!,#0!%$/0!$%2!,'50!(* !(>W08,!Z06.6!I%%)$9!Q$901!L#$+,J!"#-1!8#$+,!1#(41!$!1-.%-*-8$%,!

+-10!-%!$%%)$9!1$901!(<0+!,#0!5+0802-%.!B!'0$+1!4-,#!$!50$&!-%!,#0!,#-+2!?)$+,0+!(* !,#-1!'0$+6[!

%&+>)45 Select the Notes Pane and begin typing 

%&+>)?5 To resize the Notes Pane move your cursor over the line between the notes and slide 

area until you see a double-headed arrow. 

%&+>)@5 Click and drag the mouse to increase the size of the notes pane 

 

Figure 9. Notes pane 

 

 

! "'50!%(,01!#0+06!
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Formatting Tables and Charts 

!

"$>901!$%2!8#$+,1!$+0!)10*)9!*(+!2-159$'-%.!9$+.0!$/()%,1!(* !2$,$!-%!$%!(+.$%-@02!/$%%0+6!!

F09$,-(%1#-51!$%2!8#$%.01!>0,400%!2$,$!8$%!0$1-9'!>0!1#(4%!-%!$!,$>90!(+!8#$+,!*(+/$,6!Q(/0(%0!

4#(!8$%!+0$2!$!,$>90!(+!8#$+,!<-1)$99'!8$%!+0*0+!>$8&!,(!,#0!8(9)/%!$%2!+(4!#0$2-%.1!(+!,#0!a!

$%2!b!8((+2-%$,01!,(!/$&0!10%10!(* !,#0!2$,$6!"#0!18+00%!+0$2-%.!1(*,4$+0!>'!20*$)9,!4-99!+0$2!

,#0!-%*(+/$,-(%!-%!$!,$>90!#(+-@(%,$99';!8099!>'!8099;!+(4!>'!+(46!!Q-/590!,$>901!$+0!+0$2!0**-8-0%,9'!

>'!18+00%!+0$20+1!4#0%!,#0!8(9)/%!(+!+(4!#0$20+1!$+0!890$+9'!20*-%026!"#-1!-1!$91(!,+)0!*(+!

8#$+,1c!4#0%!2$,$!-1!0%,0+02!-%!$!8#$+,d1!20,$-9!4-%2(4!-%!3(40+3(-%,;!$!18+00%!+0$20+!8$%!+0$2!

,#0!20,$-91!(* !,#0!8#$+,d1!8((+2-%$,016!!"#0!18+00%!+0$2-%.!1(*,4$+0!8$%%(,!.-<0!,#0!-%2-<-2)$9!

8(%,0:,!*(+!,#0!,$>90!2$,$!>08$)10!-,!-1!%(,!5(11->90!,(!$11(8-$,0!80991!4-,#!,#0!+(4!$%2!8(9)/%!

#0$20+16!G20%,-*'-%.!,#0!#0$20+!+(4!-%!$!,$>90!$11-1,1!$99!1,)20%,1!$1!4099!$1!,#0!<-1)$99'!-/5$-+026!

"$>901!,#$,!15$%!/)9,-590!5$.01!1#()92!#$<0!,#0!#0$20+!+(4!+050$,02!(%!0$8#!5$.06!!

!

"$>901!$%2!8#$+,1!8+0$,02!4-,#-%!3(40+3(-%,!)1-%.!8-%+/&)*0D<+!(+!8-%+/&)PB0/&!8$%!>0!+0$2!!

/(+0!0$1-9'!>'!18+00%!+0$20+1!,#$%!4-,#!,#(10!-/5(+,02!*+(/!P:809!(+!H(+26!"(!/$&0!$!,$>90!(+!

8#$+,!/(+0!$88011->90;!5+(<-20!$!2018+-5,-(%!(* !8(%,0%,!$%2!8(%,0:,!-%!,#0!:"&+%)60-+)4#-8#)-1!

9(8$,02!>09(4!,#0!19-206!89 )1"2)7"2<.)<$E+)&")0Q"$.)/+D2$<.$-#)1"2/)+-&$/+)'B0/&)"/)&0D<+!-%!

7-8+(1(*,!3(40+3(-%,;!'()!8$%!9-%&!,#0!(+-.-%$9!1()+80!2(8)/0%,!Z8#$+,!(+!,$>90[!*+(/!P:809!(+!

7-8+(1(*,!H(+2!)1-%.!$!#'50+9-%&6!"#0!(+-.-%$9!1()+80!2(8)/0%,1!/)1,!>0!$88011->90!-%!(+20+!

*(+!,#0!$88011->-9-,'!090/0%,1!,(!,+$%1*0+!,(!,#0!3(40+3(-%,6!

Insert Table 

%&+>)45 Copy original table data from Excel and Word documents 

%&+>)?5 Select the Insert tab from the ribbon menu at the top of the screen 

%&+>)@5 Select the Table icon on the Insert tab ribbon 

%&+>)A5 Choose the number of rows and columns you would like to insert into your PowerPoint 

presentation by highlighting the squares in the table dialogue box and press Enter 

%&+>)G5 Input your data accordingly into rows and columns 

%&+>)J5 Input header row and column names to help identify data 

3$#2/+)4R5)L..$-#)0)&0D<+)

Choose the number of rows and 

columns you would like to insert, 

highlight the squares in the table 

dialogue box and press Enter. 
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Insert Chart 

%&+>)45 Select the Insert tab from the ribbon menu at the top of the screen 

%&+>)?5 Select the Chart icon on the Insert tab ribbon. 

%&+>)@5 Copy original chart data from Excel or Word documents 

Edit Chart 

%&+>)A5 To paste the data, select Chart Tools, Design from the ribbon menu on the top screen  

%&+>)G5 Select Edit Chart 

%&+>)J5 Two windows will open side by side.  

05 On the left, you will see a window with the title Microsoft PowerPoint. It will 

include the name of the file. This is the PowerPoint slide presentation.   

D5 On the right, you will see a window with a title Chart in Microsoft Office 

PowerPoint, Microsoft Excel. This is the window where you will paste your data 

%&+>)K5 P%,0+!,#0!20,$-91!(*!a!$%2!b!$:01!$%2!8#$+,!%$/06!L9-8&!=S!
!

3$#2/+)445)8-%+/&)PB0/&)

!
!

 

 

1.    Select Insert tab !

2.    Select the Chart icon !

3.    Highlight a chart of your choice. 

Insert by clicking OK.!
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3$#2/+)4?5)T.$&$-#)0)PB0/&)

 

 

 

 
 

 

 

 
3$#2/+)4@5)6"7+/6"$-&)$-&+/90'+)%B"7$-#)'B0/&)0-.).0&0)

 

 

 

 

 

 
 

!

!

TIP:  G,!-1!<0+'!-/5(+,$%,!,(!$<(-2!)1-%.!,$>1!(+!15$801!,(!8+0$,0!,$>901!(+!8(9)/%16!"#0!

<-1)$9!$550$+$%80!/$'!9((&!9-&0!$!,$>90!(+!8(9)/%c!#(40<0+;!,$>>02!,0:,!$%2!2$,$!2(!%(,!#$<0!

,#0!1,+)8,)+0!$%2!4-99!%(,!>0!+08(.%-@02!$1!0-,#0+!$!,$>90!(+!$!8(9)/%6!"#0!-%*(+/$,-(%!4-99!

%(,!>0!$88011->90!(+!+0$2$>90!>'!$11-1,-<0!,08#%(9(.-016!!

TIP: !Q8+00%!+0$2-%.!1(*,4$+0!8(%,-%)01!,(!#$<0!2-**-8)9,'!+0$2-%.!8(/590:!,$>901!8+0$,02!-%!

H(+2!4#0%!,$>901!#$<0!80991!(* !2-**0+0%,!#0-.#,1!(+!$!<$+'-%.!%)/>0+!(* !8(9)/%1!50+!+(46!

e6$!!!!!U$'/"%"9&)

6"7+/6"$-&)5+010%,$,-(%)

e6>!!!PB0/&)$-)U$'/"%"9&)=99$'+)6"7+/6"$-&N)

U$'/"%"9&)T,'+<6!G%5),!2$,$!#0+06)

S6!!!Q0908,!T.$&)V0&0)

f6!!!Q0908,!PB0/&)*""<%N)V+%$#-!
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RESOURCES  

Online Resources  
I2<$%802!/0,#(21!*(+!/$&-%.!3(40+3(-%,1!$88011->90;!-%!$22-,-(%!,(!,#0!+0?)-+0/0%,1!$>(<0;!$+0!
$1!*(99(41J!

! P+-8!70'0+!QS!19-20!1#(4!8(%<0+1-(%!,((9J!!#,,5JUU/0'0+40>68(/U0+-8U,((91U1SU!
! L(%<0+,!3(40+3(-%,!,(!N"7M!)1-%.J!
H0>!3)>9-1#-%.!H-@$+2!!!#,,5JUU4446<-+,)$9SCT68(/U!

! L(%<0+,!3(40+3(-%,!,(!N"7M!)1-%.!J!M081#$+0!"),(+-$9!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
#,,5JUU4446#)/>(92,602)Ug,+$-%-%.U9081#$+0UM08Q#$+0H-%2(41652*!

! M081#$+0!3+(2)8,!1-,0J!#,,5JUU44469081#$+068(/U!

 CSU Online Resources   

!
! LQK!I88011->90!"08#%(9(.'!G%-,-$,-<0J!#,,5JUU44468$91,$,0602)U$88011->-9-,'!!!

! 3+(*011-(%$9!=0<09(5/0%,!I88011->90!"08#%(9(.'J!

#,,5JUU,0$8#-%.8(//(%16829602)U$88011U!!

Getting Help on Your Campus 

h-1-,!,#0!LQK!I88011->90!"08#%(9(.'!G%-,-$,-<0!F01()+801!40>!5$.0!*(+!9-%&1!,(!8$/5)1!I"G!

40>1-,01!4#0+0!'()!8$%!.0,!/(+0!-%*(+/$,-(%!(%!#(4!,(!.0,!#095!(%!'()+!8$/5)1J!

#,,5JUU44468$91,$,0602)U$88011->-9-,'U+01()+801U!!

!

!

Acknowledgement  

!

"#-1!,),(+-$9!4$1!8+0$,02!$,!Q$%!O+$%8-18(!Q,$,0!K%-<0+1-,'!)1-%.!/$,0+-$9!$2$5,02!*+(/!10<0+$9!

LQK!8$/5)101!-%89)2-%.!Q$%!i(10;!Q$8+$/0%,(;!N)/>(92,;!Q$%!M)-1!E>-15(;!M(%.!A0$8#!$%2!

,#0!L#$%%09!G19$%216!Q508-$9!,#$%&1!,(!A(>!7('80!*+(/!,#0!L0%,0+!*(+!"0$8#-%.!$%2!O$8)9,'!

=0<09(5/0%,!$,!Q$%!O+$%8-18(!Q,$,0!K%-<0+1-,'!*(+!20<09(5/0%,!(* !-%1,+)8,-(%$9!/$,0+-$916 

http://www.calstate.edu/accessibility/resources/
http://www.calstate.edu/accessibility/resources/
http://meyerweb.com/eric/tools/s5/
file://localhost/Users/jeanwells/Downloads/Web%20Publishing%20Wizard%20%20http:/www.virtual508.com/
http://www.humboldt.edu/%7Etraining/lecshare/LecShareWindows.pdf
http://www.humboldt.edu/%7Etraining/lecshare/LecShareWindows.pdf
file://localhost/Users/jeanwells/Downloads/Lecshare%20Product%20site:%20http:/www.lecshare.com/
http://www.calstate.edu/accessibility
http://teachingcommons.cdl.edu/access/
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